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Outline
�

➢Challenge: Chemical Evaluation 
➢Problem: Linking chemical to potential health effect 
➢Approach: Adverse outcome pathway 
➢Solution: Semantic / knowledge-based tools 
➢Case-study 
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Challenge: Evaluating Chemicals
�

13,781/84,000 Chemicals on TSCA Inventory 
(so far) 
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Chemical Evaluation: 
A Complex Systems Problem
�

Hepatocytes 

Kupffer Cells 

Molecular 
Pathways 

Cellular Chemical 
Responses 

Tissue 
Changes 

Adverse 
Effects 

➢ ➢Problems: Semantic solution 
➢ ➢Exposure Domain-specific ontology – 

➢ Adverse Outcome Pathways – Toxicology 

➢Describe key components of the Describe normal biology & 
system from molecular to injury chemical perturbation 

➢ ➢Dose-dependent responses – Enable automated reasoning 
➢Simulate dynamic behaviour of Useful for quantitative modeling 

system following chemical 
exposure 

Office of Research and Development Not for distribution 
National Center for Computational Toxicology 



  

 

     

     

   
   

 

   
    

    
   

     
  

    
   

    

  

     

Adverse Outcome Pathways
�

● Some history 

–	 Mode of Action (MoA) framework 

–	 21st Century Tox – “Toxicity
�
Pathways”
�

–	 Conceptual framework for
�
evaluating ecological outcomes
�

● On-going efforts: 

–	 OECD: Molecular Screening.
�
Define “template” to standardize
�
development and submission of
�
AOPs for regulatory application
�

–	 Effectopaedia: EU effort to store
�
and organize AOPs
�

–	 EPA AOP Wiki: EPA/CSS-OECD AOP: PPARα → Rodent Liver Cancer 
collaboration to curate AOPs 

–	 …. many other efforts …. 

● Standardization is important! 
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Many possible pathways 


Molecular 
Effects 

Cellular 
Functions 

Cellular
�
Effects
�

Hepatocyte 
Necrosis 
Apoptosis 
Proliferation 

Kupffer cell 
Activation 
Phagocytosis 

. 

. 

. 

. 

. 

Adverse 
Outcomes 

Hypertrophy 
Injury 
Inflammation 
Regeneration 

Steatosis 
Cholestasis 
Fibrosis 
Cirrhosis 

Hyperplasia 
Pre-neoplasia 
Neoplasia 

Internal
�
Dose 

Absorption 

Distribution 

Metabolism 

Excretion 

Receptor 
Activation 

Signal-transdu 
ction 

Gene 
expression 

Metabolism 

. 

. 

. 

. 
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Endoplasmic 
Reticulum 

Mitochondrial 
Function 

Peroxisomal 
Function 

Cytoskeletal 
Architecture 

Stress 
Pathways 
. 
. 
. 
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Pathway Inference / Reconstruction
�

Molecular 
Effects 

Cellular 
Chemicals 

Cellular 
Functions Effects 

Adverse 
Outcomes 

1.Define Hepatic 
Adverse 

Outcomes 

2. Mol. Init. 
Events: 

Nuclear Receptors 

3. Intermediate 
Effects 

Top-down – i.e. Hypothesis-driven – Evaluate hypothesis using 
weight of evidence. Resource intensive. 

Bottom-up – i.e. Data-driven – Computational tools organize 
evidence and use heuristics to generate hypotheses. Results not 
always relevant. 
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Data→ Semantics → Knowledge
�

● Semantic model / Ontology 

–	 Referential vocabulary –
�
standardize entities (things)
�

–	 Relational vocabulary –
�
standardize linkages
�

● Ontology for modeling Toxicity
�
Pathways (OnToP):
�

– Referential vocab (Table 1) 

– Relational vocab (BFO) 

● Concretely expressed: 

– OWL/RDF 

– N3,Turtle, LISP, etc. 
Shah et. al., PLOS Computational Biology (in revision) 

● SPARQL endpoint (Intranet) 
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DEHP and DCB     suppress rat hepatocyte apoptosis

  

 

      

Domain knowledge → Literature
�

Natural Language 

DEHP and DCB were both able to suppress rat
hepatocyte apoptosis 

Disturbances of the mitochondrial membrane, 
induced by CCl4 treatment, were also
evidenced as increased mitochondrial swelling 

In DENA-initiated C3H and C3B6F1 mice, 
phenobarbital increased the labeling index in
eosinophilic foci, while decreasing the labeling
index in normal/non-involved hepatocytes
with/without DENA initiation. 

In contrast, PB, a non-genotoxic rodent
hepatocarcinogen, enhances the growth of
hepatic focal lesions in mice and rats by
increasing cell proliferation and inhibiting
apoptosis. 

However, humans give a therapeutic response
to the fibrate PPs via an alteration in lipid
metabolism mediated by PPARalpha. 

Acetaminophen treatment increased the plasma
levels of aspartate transaminase, alanine
aminotransferase, and alkaline phosphatase
and caused hepatic DNA fragmentation and
hepatocyte necrosis. 

Natural Language Processing 

chemical cell-event 

Evidence 

were both able to 

organism action cell 

hepatocyte 

rat 
location 

location 

Semantics Effect 

DEHP apoptosis decrease 

agent object 

change 

Effect d20∧hasAgent d20, c101 ∧hasObject d 20, e20 ∧hasChange d20, +∧ 
Assertion Chemical c101∧MolEvent e20 ∧hasEvidence d20, f 1020∧Literature f 1020∧ 

hasName c101, DEHP∧hasExtId c101, CAS:117-81-7∧ 
hasName e20, apoptosis ∧hasExtId e20, GO:0006915 

Shah et. al., PLOS Computational Biology (in revision) 
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Ontology for Toxicity Pathways: OnToP
�

Substances 
Measurable
�

Biological molecules, 
cell, anatomic 
locations, tissues 

Organisms and their 
attributes 

Phenomena 
Events 

Pathways: chain of 
events 

Effects 
Changes in events 

Chemical-effects 

Latent-effects 

CAR, TCPOBOP, c-Myc 

Liver, rat 

CAR-activation, c-Myc-activation,
�
cell proliferation, hyperplasia
�

TCPOBOP induced CAR-activation 

FoxM1-activation increases cell 
prolferation 
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Evidence from Literature
�

Shah et. al., PLOS Computational Biology (in revision)
�
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DEHP apoptosis

epatocyte

rat     

HTS data – molecular & cellular effects
�

h 
location 

HepG2 

Hs Shah et. al., in preparation 

location 

agent Effect 

decrease 

object 

change 

Triclosan MMP 
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Workflow
�

Inputs Modules & Workflows Outputs 

Information 
Retrieval 

Article
Article

Articles 

Public 
Data 

Full-text 
searching 

Format 
conversion 

MongoDB 

Information 
Extraction 

Entity 
Identification 

Relation 
Extraction 

REST/ 
SPARQL 

ACToR ToxRefDB 

Semantic 
Mapping 

AllegroGraph 

ToxMiner ToxCast 
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vLiver Knowledge-base
�

Formal Ontology 
OWL/RDF; n3 

Entities (with external links) 
Chemicals > 13,781 
Effects > 1,225,869 
Assays > 38,294 
Targets > 48,743 

Sources: 
PubMed >1e6 
ToxCast 1008242 
ToxRef 135512 
PubMed/CTD: 82,020 
PubMed/v-Liver: 2,302 

Accessible: Literature – largest 
SPARQL endpoint source of evidence .. 
REST 
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Case Study
�

Browse evidence for chemicals 
Identify nuclear receptor activators 
Visualize evidence 
Making inferences about mechanisms 
Automated inference – pathways 
Hypothetical pathways to adverse outcomes 
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WY-14,643 Effects → Structured
�

>	
 WY-14643 molecular-effect ID: 5153011eb9743f479d00096f


Effect: dec HBA-A1 mRNA expression in mouse


Evid: Qu, A et al,(2010). "PPARalpha-dependent activation of cell



cycle control and DNA repair genes in hepatic nonparenchymal


cells." Toxicol. Sci. 1096-0929



>	
 WY-14643 molecular-effect ID: 5153011db9743f479d00096e


Effect: dec PRP19 mRNA expression in mouse


Evid: Han, ES et al,(2008). "The in vivo gene expression signature


of oxidative stress." Physiol. Genomics 1531-2267



>	
 WY-14643 molecular-effect ID: 5153011cb9743f479d00096b


Effect: dec ARF2 mRNA expression in mouse


Evid: Iida, M et al,(2003). "Changes in global gene and protein



expression during early mouse liver carcinogenesis induced


by non-genotoxic model carcinogens oxazepam and

Wyeth-14,643." Carcinogenesis 0143-3334



>	
 WY-14643 molecular-effect ID: 5153011cb9743f479d000969


Effect: inc COPB1 mRNA expression in mouse


Evid: Sanderson, LM et al,(2008). "Effect of synthetic dietary



triglycerides: a novel research paradigm for nutrigenomics."


PLoS ONE 1932-6203



>	
 WY-14643 molecular-effect ID: 5153011bb9743f479d000968


Effect: inc HNRNPF mRNA expression in rat


Evid: Ren, H et al,(2009). "Evidence for the involvement of


xenobiotic-responsive nuclear receptors in transcriptional


effects upon perfluoroalkyl acid exposure in diverse


species." Reprod. Toxicol. 1873-1708



>	
 WY-14643 molecular-effect ID: 5153011ab9743f479d000967


Effect: dec ATP11C mRNA expression in mouse


Evid: Han, ES et al,(2008). "The in vivo gene expression signature



of oxidative stress." Physiol. Genomics 1531-2267



>	
 WY-14643 molecular-effect ID: 5153011ab9743f479d000964


Effect: inc PTPN4 mRNA expression in mouse


Evid: Sanderson, LM et al,(2008). "Effect of synthetic dietary



triglycerides: a novel research paradigm for nutrigenomics."


PLoS ONE 1932-6203



>	
 WY-14643 molecular-effect ID: 51530119b9743f479d000963


Effect: inc FABP3 mRNA expression in mouse


Evid: Ren, H et al,(2009). "Evidence for the involvement of



xenobiotic-responsive nuclear receptors in transcriptional

effects upon perfluoroalkyl acid exposure in diverse


species." Reprod. Toxicol. 1873-1708



>	
 WY-14643 molecular-effect ID: 51530119b9743f479d000962


Effect: inc HES3 mRNA expression in mouse


Evid: Qu, A et al,(2010). "PPARalpha-dependent activation of cell



cycle control and DNA repair genes in hepatic nonparenchymal


cells." Toxicol. Sci. 1096-0929



>	
 WY-14643 molecular-effect ID: 51530118b9743f479d00095f


Effect: inc TOMM20 mRNA expression in mouse


Evid: Han, ES et al,(2008). "The in vivo gene expression signature



of oxidative stress." Physiol. Genomics 1531-2267



>	
 WY-14643 tissue-effect ID: 5152102fb9743f56860006bd


Effect: inc Atrophy in Testes hamster


Trt: 42.0 mg/kg/day 13.0 week


Evid: (4-Chloro-6-(2,3-xylidino)-2-pyrimidinylthio) acetic acid



(WY-14643) Subchronic oral toxicity in rodents in hamster


>	
 WY-14643 tissue-effect ID: 5152102fb9743f563a000703



Effect: inc Mitotic Alteration in Liver mouse


Trt: 12.0 mg/kg/day 13.0 week


Evid: (4-Chloro-6-(2,3-xylidino)-2-pyrimidinylthio) acetic acid



(WY-14643) Subchronic oral toxicity in rodents in mouse


>	
 WY-14643 tissue-effect ID: 5152102fb9743f563a000704



Effect: inc Apoptosis in Liver mouse


Trt: 22.0 mg/kg/day 13.0 week

Evid: (4-Chloro-6-(2,3-xylidino)-2-pyrimidinylthio) acetic acid



(WY-14643) Subchronic oral toxicity in rodents in mouse


>	
 WY-14643 tissue-effect ID: 5152102fb9743f563a000706



Effect: inc Mitotic Alteration in Liver mouse


Trt: 22.0 mg/kg/day 13.0 week


Evid: (4-Chloro-6-(2,3-xylidino)-2-pyrimidinylthio) acetic acid



(WY-14643) Subchronic oral toxicity in rodents in mouse



>	
 WY-14643 molecular-effect ID: 51625b9fb9743f53ef0000df


Effect: inc NF-kB activation in Liver rat


Evid: Fischer, JG et al,(2002). "Moderate iron overload enhances


lipid peroxidation in livers of rats, but does not affect


NF-kappaB activation induced by the peroxisome proliferator,


Wy-14,643." J. Nutr. 0022-3166



>	
 WY-14643 molecular-effect ID: 51625b9fb9743f53ef0000e1


Effect: alter Gap Junctional communication in Liver rat


Evid: Mally, A et al,(2002). "Non-genotoxic carcinogens: early


effects on gap junctions, cell proliferation and apoptosis


in the rat." Toxicology 0300-483X



>	
 WY-14643 cell-effect ID: 51625b9fb9743f53ef0000dd


Effect: inc Oxidative Stress in Liver rat


Evid: Conway, JG et al,(1989). "Relationship of oxidative damage



to the hepatocarcinogenicity of the peroxisome proliferators


di(2-ethylhexyl)phthalate and Wy-14,643." Carcinogenesis

0143-3334



>	
 WY-14643 cell-effect ID: 51625c48b9743f53ef00013a


Effect: inc Oxidative Stress in Liver mouse


Evid: Woods, CG et al,(2007). "WY-14,643 induced cell



proliferation and oxidative stress in mouse liver are


independent of NADPH oxidase." Toxicol. Sci. 1096-6080



>	
 WY-14643 molecular-effect ID: 51625b9fb9743f53ef0000d3


Effect: inc PPARalpha activation in Liver rat


Evid: Corton, JC et al,(2005). "Peroxisome proliferator-activated


receptors: mediators of phthalate ester-induced effects in


the male reproductive tract?" Toxicol. Sci. 1096-6080



>	
 WY-14643 molecular-effect ID: 51625c47b9743f53ef000132


Effect: inc PPARalpha activation in Liver mouse


Evid: Bility, MT et al,(2004). "Activation of mouse and human



peroxisome proliferator-activated receptors (PPARs) by


phthalate monoesters." Toxicol. Sci. 1096-6080
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Chemicals Effects – Relational
�

Summary: 
58 Chemicals 
50 Targets 
988 Effects 

# Increase 

# Decrease 
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Chemical Effects → Semantic View
�

Chemical Increase 

Decrease Molecular 
Event 

No change 

Cellular 
Function 

Histological 
Outcome 

Chemical 
Effects 

Shah et. al., Bionformatics (in revision) 
Subset of experimental evidence about 

Phenobarbital (PB) from KB
�
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Semantics → Computational Inference
�

PB CYP3A4 

PB PXR 

PXR CYP3A4 

Inference 
Algorithm 

Shah et. al., PLOS Comp Bio (in revision) 

Prior 
Knowledge 

New 
“Knowledge” 

Latent 
Effects 

Chemical 
Effect 
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Computational Inference → Hypotheses 


Plausible explanation of 
putative PB-mediated 
molecular changes 

Evidence for Mdm2 
activation by PB was not 
in the KB but has been 
shown 
experimentally 

Chemical 
Effect 

Latent 
Effects 

Hypotheses: 

PB activates Mdm2 via CAR
�
PB activates FoxO1 via PXR
�

Shah et. al., PLOS Comp Bio (in revision) 
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Computational Inference → “AOPs”
�
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Shah et. al., PLOS Comp Bio (in revision) 

Chemicals Molecular Cellular Tissue 

Phebobarb/ 
TCPOBOP 

CAR > FoxM1 Initiation > 
promotion 

Hyperplasia> 
Neoplasia 

Phebobarb/ 
TCPOBOP 

PXR > ROS DNA Damage 
> Initiation > 

promotion 

Neoplasia 

Phebobarb/ 
TCPOBOP 

CAR > Mdm2 Apoptosis ?? 

Hypothetical “AOPs” – require 
further curation 



  

     
     

     

“AOPs” → Dose Response
�

Hepatocyte
�

Quantitative systems modeling – simulating changes in 
Jack, et al. BMC Systems Biology (2011) early cell-cycle progression using in vitro data 
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Summary
�

Pathways – key to chemical evaluation 
Interpreting HTS data for new chemicals 

Quantitative dose-response modeling 

Approach: Data→Ontology→Knowledge→Inference→Hypotheses 

Implementation 
Ontology for describing toxicity pathways (OWL/RDF) 
Knowledge-base (KB) for capturing assertions (SPARQL) 

KB Visualization tool (Cytoscape/c-Mantic) 

Custom pathway-inference engine 

Broadly applicable to toxicology & AOPs 

Utility of ontology dependent on linkage with:-

Public referential vocabularies 

Public relational vocabularies 
Office of Research and Development 
Computational Toxicology Research Program 
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